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Introduction
This document provides an overview of the changes in the latest version of SAP Enable Now 2206
compared to the previous version SAP Enable Now 2111.
The changes are divided into the following categories:
o New function: Describes a new function that is not based on existing functions.

o Enhancement: Describes the enhancement of an existing function.

o Optimization: Describes improvements to an existing function.

Note for SAP Enable Now On-Premise
Before installing the new release, make sure that you have made all preparation steps for the product
update and content migration. You can find detailed information in the SAP Enable Now Upgrade Guide.

More Information
Info Center

SAP Help Portal

Product training, content and
templates, additional information...
Go to Info Center

Product manuals, installation
guides, upgrade and security
information...

SAP Enable Now Community

Product Availability Matrix

Register for up-to-date news from
the SAP Enable Now team. Stay
informed about all improvements
and changes.

Technical release information for
the current version, such as
browser- and application support,
as well as SAP Companion
availability.

Go to SAP Community

Go to SAP Help Portal

Go to Product Availability Matrix

Release Cycle and Maintenance
Plan
Get an overview about the SAP
Enable Now release cycle as well as
the supported releases and used
release numbers.
Go to Info Center
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Tip
Use the
button to gain access to the interactive training materials, and further information
about news and changes, in the SAP Enable Now Info Center (registration required).

Improvement requests and product development
Improvement requests
Do you have suggestions on how we can improve SAP Enable Now? Please share them
with us on the SAP Customer Influence page. Your input is important to us, and helps us
to evaluate your inquiries, give feedback, and take them into consideration when
planning our next releases, based on their priority. On the page for SAP Enable Now, you
can find more information about the process and how to participate:
Go to SAP Customer Influence
Product Development
With the SAP Customer Engagement Initiative (CEI), you, as an SAP customer or
partner, gain early insights into SAP’s product developments and work directly with
developers to define and shape future product orientations.
The SAP Enable Now team offers customers interesting opportunities to influence the
development of SAP Enable Now.
Go to SAP Customer Engagement Initiative

Do you know that SAP offers a Real-Time Support?
Did you try already the Expert Chat, which is available for SAP Enable Now as well? This
Expert Chat support channel is best suited for new Medium or High priority issues.
Expert Chat provides:
•

Real-time support from an SAP Product Support Expert

•
•

Ability to screen share
Quicker resolution as compared to an incident created in the Launchpad

See SAP Knowledge Base Article for detailed steps on how to get started.
Start an Expert Chat
Go to Frequently Asked Questions
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General Changes and News
New Info Center Appearance

The Info Center has been optimized with regards to clarity, readability, and handling of all content and the
overall structure has been simplified. The tile view has been replaced by a lighter list view from the second
level navigation. A news banner on the entry page informs about current news. The most popular and
recent content is also displayed in a separate section on the entry page.

Enable Now
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Akamai Support for SAP Enable Now Cloud Edition
The SAP Enable Now cloud edition now supports Akamai as a
content delivery network. By using Akamai, the geographical
distribution of content is improved so that the content can be
loaded without performance restrictions according to the location
of the users.
Please note that you need an Akamai contract to use this feature.
For further details, please contact Nicole Kraska from Akamai.
Enhancement SAP Enable Now (Cloud Edition)

Enable Now

Single Sign-On with SAML for SAP Enable Now On-Premise
To support customer landscapes with a consistent authentication
approach, SAML is now supported for the SAP Enable Now on-premise
edition (HANA) as a single sign-on method.

New Function SAP Enable Now (On-Premise Edition)

Microsoft® Windows 11 Support
The installation of the SAP Enable Now components Producer,
Instant Producer, SAP Companion for desktop is now supported
on Microsoft® Windows 11, as well as the recording and playback
of content.
Enhancement SAP Enable Now
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Deleting Users
To improve the user management of SAP Enable Now, users can be deleted
directly in the user view. This allows to remove users that are no longer needed
and affects their associated user data as well. Existing references, such as task
assignments, can be replaced with a substitute user.
In the Administration > Users view, you can now find the Delete button, which
you can use to delete one or more selected users. Note that no system users
can be deleted, as well as the user currently logged on.
The feature was implemented as a result of an inquiry in the SAP Customer Influence Portal:
Feature Request.
New Feature Manager

Activating deactivated users at SAML login
If a user is deactivated in the SAP Enable Now Manager and logs on using
Single sign-on with SAML, this user is now automatically reactivated. Users
can be deactivated automatically if they do not log on to the Manager for a
specific period of time. See also the server settings Automatic User
Deactivation.
To reactivate deactivated users, you must activate the option Automatically
Enable SAML User at Logon in the Server Settings.

Enhancement Manager
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UI Optimizations for Server Housekeeping

The server housekeeping user interface has been optimized to make it easier to use. The analysis options
and buttons are now arranged in the toolbar. After analyzing the data, the types and values found are
displayed clearly in a list.
It is also possible to display an overview of all users to be deleted in a preview. This makes it easier for you
to decide whether a user should be deleted or reactivated in the user view.
Optimization Manager

Force Password Change for Passwords Reset by Administrator
If an administrator resets a user's password, the next time the
user logs on to the Manager, the user can be prompted to specify
a new password. In the server settings under Security, there is the
following new setting for this:
•

Force password change on login for passwords reset by
administrator

Enhancement Manager
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App Launcher for Starting Desktop Components
With this release, desktop components are always started with the SAP Enable
Now App Launcher, the start via the Java Web Start feature included in Oracle
Java Runtime Environment 8 is not possible any longer. Since Oracle will no
longer officially support Java Runtime Environment 8 since March 2022, this
feature has been removed.
The change does not affect customers who are already using the SAP Enable
Now App Launcher. For more information about the SAP Enable Now App
Launcher, see the App Launcher Guide.
Producer, Instant Producer, Companion for Desktop, App Launcher

Note on Using Microsoft Internet Explorer 11
SAP Enable Now uses an embedded Microsoft Internet Explorer 11 to present
certain content e.g., in Producer. As Microsoft restricts the support of Internet
Explorer, it will be replaced by Microsoft Edge WebView2 in all desktop
components with the next 2211 release of SAP Enable Now. WebView2 is
based on Microsoft Edge (Chromium) and allows you to embed Web
technologies that are necessary for editing and displaying content.
In this release of SAP Enable Now, Microsoft Internet Explorer 11 is still used as
embedded browser.

Note on SAP Enable Now Google Chrome Extension
With this release, the deprecated Google Chrome Extension SAP Enable Now is
no longer supported. As a result, only the Google Chrome Extension
Enablement Assistant can be used for simulation captures and playback of
SAP Companion for desktop.
We therefore recommend that you install the current Google Chrome
extension.
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Content Organization and Collaboration
Auto-Check for Assigned Content
Each time the Producer is started, the system automatically
checks whether new assigned content exists on the Manager. This
enables you to download the objects required for processing
directly at any time. A dialog box indicates that new objects are
available when the Producer is started.

Optimization Producer
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Rapid learning and simulations
Start Value for Numbered Lists
In the text editor, a start value for numbered lists can be defined.
This allows to start a list with an individual value, for example, to
continue a split list in two text fields.
Double-clicking a list opens a dialog to determine the start value.

The feature was implemented as a result of an inquiry in
the SAP Customer Influence Portal: Feature Request.
Enhancement Producer, Manager

Count Down Counter Object
As an additional action for the counter object, this can now also
be counted down to enable a more diverse use. For example, this
allows to easily create gamification elements where a live is
deducted for wrong answers and is awarded for completing a
specific challenge.
The feature was implemented as a result of an inquiry in the SAP Customer Influence Portal:
Feature Request.
Enhancement Producer
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Anonymizing Multiple Screenshot Areas
When anonymizing screenshots for simulations in SAP Enable
Now Producer, multiple areas can be edited at once within in the
editing dialog. This simplifies the anonymization of screenshots
representing various sensitive data. In addition, the feature can
also be applied as a mass change to multiple selected
screenshots.
To anonymize an additional area, in the Anonymize Screen Area
dialog, drag a rectangle to the required position while holding
down the mouse button.
The feature was implemented as a result of an inquiry in the SAP Customer Influence Portal:
Feature Request.
Enhancement Producer

Further Options for Comic Avatars
The comic avatars have been enhanced with various features to make them
even more versatile. For Comic Man and Comic Woman, a mask and hood can
now be displayed to use the avatars for learning content for the medical and
food area. For Comic Woman, a pair of trousers can be selected as an
alternative to a skirt.
The feature was implemented as a result of an inquiry in the SAP
Customer Influence Portal: Feature Request.

Enhancement Producer
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In-App Help
In-App Help Solutions Renamed to SAP Companion

SAP Companion accompanies the user in their daily business life's, acts as the trusted advisor, provides
support when needed, takes care on the initial onboarding as well as on-the-fly enablement and drives the
change management together with the user.
In previous releases, the two components were harmonized to provide a consistent user experience of inapp help for both desktop and web applications. With the 2206 release of SAP Enable Now, the
components Web Assistant and Desktop Assistant have been renamed to SAP Companion. Dedicated
hints with regards to Desktop Assistant will be mentioned as SAP Companion for desktop.

SAP Companion

Watch the video

SAP Companion for Non-SAP Solutions
SAP Companion can now be integrated in 3rd party solutions to
enable a consistent in-app enablement experience even
for heterogeneous software landscape.
Please check out with your SAP consultant or partner whether
your application can be supported - and to which extend. They will
conduct a technical feasibility analysis first to understand possible
limitations and to discuss how to deal with them.
New Feature SAP Companion
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Real-Time Machine Translation for SAP Companion
SAP Companion users can now easily translate in-app content with a single
click to match the UI language of the application. This allows customers to
change their localization strategy and to save time and
resources by providing the in-app content for the core
languages only.
Please note a separate license is required for SAP Translation Hub.

New Feature SAP Companion

SAP Concur Integration
SAP Companion is now also available in SAP Concur. You can
create your own SAP Companion content to help users adapt
their processes directly in the application and ensure
productivity. To do so, create your context help, guided tours, and embedded learning in SAP Enable
Now.
For more information, see the SAP Companion Integration Guide on SAP Help Portal.
Note: The integration is planned for July 6th 2022 by SAP Concur.
New Feature SAP Companion

SAP Ariba Guided Buying Integration
SAP Companion has been integrated into SAP Ariba Guided
Buying. The interactive help is already activated and contains a
selection of content to provide users with the help they need if
they need it. You can create your own SAP Companion content to help users adapt their processes
directly in the application and ensure productivity. To do so, create your context help, guided tours, and
embedded learning in SAP Enable Now.
For more information, see the SAP Companion Integration Guide and the blog.
New Feature SAP Companion
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SAP Companion Release Newsletter
Register for the SAP Enable Now In-App Help Preview newsletter and release
to receive regular updates on upcoming releases for SAP Companion.
Go to Info Center

SAP Companion

SAP Companion Overview of Applications and Content

The SAP Help Portal contains an overview of all applications in which SAP Companion is integrated. It also
lists the available content and the possible integration types. This allows to easily see the availability of
SAP Companion for your SAP applications.
Go to SAP Help Portal
Go to SAP Learning – User Adoption Solutions
SAP Companion
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Quick Help
Hotspots can now be set to appear immediately on the
screen without users having to manually open the
SAP Companion first.
This allows to display important information for errorprone fields or other on-screen elements proactively to
drive change management, or provide mandatory
element help, notes, or warnings where required.
Help tiles marked as Quick Help will not be displayed in
the help panel to keep the amount of information low.
Note: If the parameter readCatalogue=false is set, the
Display Immediately option is being ignored.

New Feature SAP Companion

Enable Now

Inserting Links and Media Content
To simplify content creation, media content can be added into context help bubbles and guided tours
steps easily from within the SAP Companion editor.
•
•
•

Link: Just choose between Free Link for any URL and App Navigation Link to jump to other
applications or application pages.
Video: Simply add the URL for the selected video, additionally a preview image for the video can
be provided.
Image: Easily add the URL for an image and specify an alternative text to ensure accessibility.

You can insert a link, video, or image using the Insert menu located above the input field for the bubble
text. You can replace pasted content by double-clicking it or selecting it from the Insert menu.

New Feature SAP Companion
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Custom Help Content with SAP Standard Content
In scenarios where only custom help content has been created,
additional SAP standard content is now automatically displayed as soon
as it is delivered by SAP.
Note that in edit mode, you can also change the SAP standard content or
hide content that you do not want to display.

Enhancement SAP Companion

Notification of New Version

SAP Companion now notifies authors when a new version
has been released. After the edit mode is started, SAP
Companion displays a popup window with a link to the latest
release notes.
This notification helps content authors stay up-to-date with
the latest features and enhancements.
You can also open the release notes at any time from the
menu Options > Release Information in edit mode.
New Feature SAP Companion
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SAP Companion Onboarding

An interactive onboarding course has been added for authors to provide them with the skills they need to
instantly create delightful content for their end users. The course is free of charge and is shown proactively to first-time authors and can be accessed later via the menu Options -> Companion Onboarding in
edit mode.
New Feature SAP Companion

Customizable Toolbar Icon in SAP Fiori Apps
In Fiori systems, the help icon for the SAP Companion button can be
replaced by any other icon from SAP IconFont. This is the case, for example,
if the help icon in the toolbar is already used for another help system.
You can use the new parameter buttonIconId and a valid icon ID to change it.
You can find an overview of possible icons in the Icon Explorer.
For example: buttonIconId=explorer

?

In non-Fiori systems, this setting is ignored and the regular help icon is
displayed.
Optimization SAP Companion
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Guided Tour Processing - Hotspots
When editing a guided tour, hotspots are now displayed with the
selected type (none, rectangle, underscore) including the step
number. In the preview and during the playback of the guided tour,
the step numbers are not displayed.

Optimization SAP Companion

Optimizations for Hotspot Assignment
The following changes have been made to optimize hotspot assignment:
•

Help on Hotspot Assignment
Before the actual hotspot assignment, a help window is now displayed that explains the possible
actions and shortcuts in assignment mode. The note can be suppressed permanently by selecting
the Do Not Display Again checkbox.

•

Advanced pause of hotspot assignment
With pause hotspot assignment, you can navigate in the application without assigning hotspots,
for example, to open a dropdown list. You can now pause this as long as you need it instead of just
for one action as before.
In addition to the Shift+A hotkey, you can now stop the mapping mode by clicking the middle
mouse button. To resume the assignment mode, press Shift+A or the middle mouse button again.

Optimization SAP Companion
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Hiding the Learning Center button
The display of the Learning Center button on the Learning
tab can now be disabled by using the parameter
showLearningCenter=false. As a result, only the learning
content that is available and relevant for an app is
displayed, and the users do not see all the content of the
learning center.

Optimization SAP Companion

Help Panel with Close Button
A close button is now displayed by default in the SAP
Companion help panel.
Previously, this button had to be enabled via parameter
showCloseButton=true. This is no longer required.
However, if you do not want to display the close button, you
can set the parameter to false.

Optimization SAP Companion
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Improvements to the Edit Dialog Box
In the dialogs, optimizations have been made to improve the use.
Edit Dialog Box
•
•

The Lightbox Sizing option for link tiles has been changed from a slider to buttons with icons.
The edit dialog box is no longer attached to a help tile or hotspot and therefore does not jump to
another position if the hotspot is assigned to another screen element. The dialog box is displayed
centered on the screen by default and can be moved to any position by dragging the header.
If the edit popup is moved on the screen, its position is now saved to open it the next time in the
same position.
The size of the dialog box and the Text and Appearance tabs have been optimized to display all
available options without condensed groups.

Color Accumulation
•
•

Dialog boxes and messages now have a primary button for the recommended action which is
highlighted by a color.
In Quartz themes, secondary texts (such as labels and tile descriptions) are now less different:
they are set to 80% opacity.

Optimization SAP Companion
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SAP Companion with SAP Horizon Themes

SAP has introduced the new SAP Horizon theme for an optimized user experience. SAP Companion now
also supports the new theme. There are two themes, the light theme SAP Morning Horizon and the dark
theme SAP Evening Horizon. SAP Companion uses the opposite theme of the active theme to ensure a
clear distinction between the app itself and the help overlay.
The themes can be also set by using the parameter theme=horizon or theme=horizondark.
Enhancement SAP Companion

SAP Companion with SAP Belize Themes
Two more themes for SAP Companion have been added, Belize and Belize
Deep, to display help content with a matching color scheme.
If a Fiori app uses the SAP Belize (light) theme, SAP Companion is now
automatically set to the SAP Belize Deep (dark) theme and vice versa. This
ensures a clear distinction between the app itself and the help overlay.
The themes can be also set by using the parameter theme=belize or
theme=belizeplus.
Enhancement SAP Companion
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Analysis and Reports
Subscribing to Report Filters
You can now also subscribe to saved report filters to get the most
up-to-date data about a report on a regular basis. You can specify
the recurrence and the time period for which you want to receive
the report. The report is sent as a mail with an XLSX file.
Next to the filter menu is the Add Subscription to Filter button. It
allows you to configure a subscription to the currently active filter.

New Feature Manager (HANA/Cloud)

Enable Now

Optimizations for the User Interface and Charts of the Reports
Various optimizations have been made for displaying reports in the SAP Enable Now Manager. These
include:
•

•

•

•
•

•

Displaying values in the bar chart
In reports with a bar chart, you can now display the values directly on the bar or hide them if you
do not need them. The Display Values in Chart button is available in the toolbar for this purpose.
Harmonization of the bar charts
The bar charts in the reports have been harmonized for a uniform display. In addition, the values
are sorted by default from highest to lowest value.
Filter Selection
The filters in the reports are now displayed consistently. Unneeded picklists for a report have
been removed.
Tracking events
Missing tracking events have been added to the Context Help and Content Visits reports.
Display of zero values
The display of zero values of reports is now also displayed in the chart and is therefore easier to
follow.
Y axis display
The Y axis scale remains the same for reports with multiple pages and therefore allows consistent
display.

Optimization Manager (HANA/Cloud)
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Optimizations for Reports in Microsoft Power BI Desktop
The following optimizations have been made for using Microsoft
Power BI Desktop to display reports:
•

•

Copying the request URL
You can use the Copy Request URL button in the new
reports to copy the request URL directly so that you can
use it easily in Microsoft Power BI.
Specifying the Report Data
You can now specify the data to be displayed for
displaying the reports in Microsoft Power BI to display
only the information you require. As a result, you can still
reduce the server load and the response time when calling
the reports.

Enhancement Extension Manager (HANA/Cloud)
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Integration
Optimized Import of SAP Signavio Structures
The native interface between SAP Signavio and the SAP Enable
Now Producer enables quick and easy addition of documentation
and other knowledge objects such as simulations or courses to
SAP Signavio process structures.
SAP Signavio processes including substructures can be imported
directly into the Producer via the menu Tools -> Business Process
Model -> SAP Signavio Import to enrich them with learning
content.
Links to the published learning content can then be exported and
accessed directly by SAP Signavio via the corresponding process node.

Optimization Producer
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Important Disclaimers
This document is for informational purposes only. The content is subject to change at any time without
notice and SAP does not warrant that the document is error-free. SAP MUST NOT APPLY ANY
WARRANTY, NOT EXPRESENTIALLY HAVING DIFFERENTIAL, INCLUDING, BUT NOT LIMITED TO THE
WARRANTY OF MARKET DAILY AND THE PROPERTY FOR A CERTAIN PURPOSE.

Code- Examples
The software source- code and/or object code contained in this documentation (“Code”) is only an
example representation. This code is never suitable for use in a productive system. The code is only
intended to provide an example of how source code can be created and designed. SAP does not warrant
the correctness and completeness of the Code given herein, and SAP shall not be liable for any damages
caused by the use of the Code, unless damages were caused by SAP intentionally or grossly negligent
conduct.

Accessibility
The information contained in the documentation of the SAP- Library represents SAP's view of
accessibility criteria at the time of publication and is not intended to be a mandatory guideline on how to
ensure the accessibility of software products. In particular, SAP disclaims any liability with respect to this
document from which no contractual obligations arise, either directly or indirectly.

Gender-Neutral Language
If possible, the SAP- documentation is gender neutral. Depending on the context, the direct form of
address with "you" or a gender-neutral noun (such as "Professional" or "Person Days"). If the third person
singular cannot be avoided when referring to persons of both sexes, or if no gender-neutral noun exists,
the masculine form of the noun and pronoun is used throughout for reasons of better readability. This
ensures that the documentation remains understandable.

Internet Hyperlinks
The SAP- documentation can contain hyperlinks to the Internet. These hyperlinks are only intended to
serve as a hint on supporting and further documentation. SAP does not warrant the availability or
correctness of this Supplemental Information or its usability for a particular purpose. SAP shall not be
liable for any damages caused by the use of related information unless damages have been caused by
SAP's gross negligence or willful misconduct. For information about link classification, see
http://help.sap.com/disclaimer.

© 2022 SAP SE or an SAP- affiliate company. All rights reserved.
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